HP SmartStream Designer

HP Mosaic 3.0 - Dynamic Personalization

How-to Guide

Pt

July2016



© Copyright 2014-2016 HP Development
Company, L.P.

Reproduction, adaptation, or translation without
prior written permission is prohibited, except as
allowed under the copyright laws.

The information contained herein is subject to
change without notice.

The only warranties for HP products and
services are set forth in the express warranty
statements accompanying such products and
services. Nothing herein should be construed as
constituting an additional warranty. HP shall not
be liable for technical or editorial errors or
omissions contained herein.

HP, HP Indigo Press, HP Indigo Press RIP, and HP
Indigo Electrolnk are trademarks or registered
trademarks of HP.

Adobe PostScript is a trademark of Adobe
Systems Incorporated.

MS Windows and Windows are U.S. registered
trademarks of Microsoft Corp.

All other products or name brands are
trademarks of their respective holders.

The HP Indigo press' counter feature records the
number of impressions you make using your
press. The counter does not reflect any previous
use of the press or its age.

This English version of this document must be
used as the original instructions.

The HP Indigo press is a Class 1 Laser Product
containing high voltage power supplies and
laser light sources. There is no danger to
persons or equipment when the system is
operated in accordance with the directions
provided by HP in this and other publications. All
high voltage power supplies and laser sources
are located behind protective covers. Warning
labels are attached to each protective cover. Do
not remove covers.

Part Number: CA494-14161

Revision 04: July 2016



Table of contents

T OVBIVIBW ..eeeecectreeetriestetes st s esss st ss st es s st ea s s st en bt n st et st ebss et basas st ebas b et esantes st et s snb et san s sessebasassntas et aas st ea s bbb ansesesas s s s st esananes 1
Who can benefit from reading this dOCUMEBNT? ..ottt 1
INEFOTUCTION 1ttt ettt et a st b s e b b s e et b a et et et s e st e s s ae s s s s sa et enssaebesanaesessaesessnastesneetans 1

2 Getting started With the SAMPLE JOD ...ttt ettt b s et bbbt e bbb b bt et b s bbb e bbb anbens 3

3 WOTKILOW ouveierteieeicteecictes sttt st es st sttt ba st es b et st ae bbbt sk as bbbt e s bas b e b e b s b basbes b best st bas b s e b e b baebas b e b e st et an b s b ban b st bnas 5
WOTKFLOW SEEDS oottt ettt et e et s st sa s ae s et e st s e et et s s et es s s e s esasaesesasaesesnaesnes 5
Use HP MOSQIC AItING OPTIONS ...ttt ettt a e s et et ete et et s s ee s ens s s asasasasanasssseaesesesenn 7

Edit @t the SEEA SEELBVEL ... e s 8
Edit Seed Set and Seed file PAraMEBLEIS . ...ttt 11

4 Seed file deSIgN FECOMMENTATIONS .....cvrvereereereereeeereeeseee s eessessssesssassessssssss s sssssss s s sess st sessssassassasssnesns s sanssnesen st s s sanaassassnnen 15

Seed file FECOMMENAALIONS .....vecveeeeeceeecee ettt ettt e a et s s ss s s s s enaessnsesssssaesenssnssssrsenas 15

6 Create an oUtPUL file OF HPD fEMPLATE FIlE ettt et e et eeaee s e ss e s s ee s st s sensnens 23
CrEAte AN OULPUL FILE ettt ettt a st e s e et en s e s e st s s s s enssnaeessnanenseas 23
Create an HPD tEMIPLATE FIlE ...uv ettt a et s et enanae s 23

Appendix A Service and support

Printing instructions

ENWW CA494-14161






l

Overview

Who can benefit from reading this document?

This document provides information on using the HP Mosaic Dynamic Personalization application within the HP
SmartStream Designer product. HP Mosaic is designed for HP SmartStream Designer users that want to include
variable images in jobs. Basic HP SmartStream Designer knowledge is required.

HP Mosaic 3.0 is included in the following HP SmartStream Designer software versions:
e  HP SmartStream Designer 11.4 for Adobe InDesign CC2015.4, Mac or PC

e  HP SmartStream Designer 20 for Adobe Illustrator CC2015.3, Mac or PC

HP Mosaic 2.0 is included in the following HP SmartStream Designer software versions:
e  HP SmartStream Designer 11 for Adobe InDesign CC2015, Mac or PC

e  HP SmartStream Designer 19 for Adobe Illustrator CC2015, Mac or PC

HP Mosaic can be manually updated to HP Mosaic version 3.0 for HP SmartStream Designer 6.3 for Adobe
InDesign CS6. HP Mosaic version 3.0 supports the new Shuffle Spot Colors option.

Introduction

ENWW

HP Mosaic is a Dynamic Personalization option for HP SmartStream Designer. The application is a random image
generator. It creates unique PDF files based on a template file (.txt) and one or more original vector PDF files.
The vector PDF files should have square dimensions (equal height and width).

The application takes a vector PDF file as input (also known as a Seed file)), and then generates a large number
of variations on the file by transforming it — scaling, transposition, and rotation — randomly. The output are
used as variable image assets in the graphic design of VDP jobs.

An HP Mosaic job includes a Seed Set, which is a group of one or more Seed files. The Mosaic image files that are
output are created from these Seed files.

The output HP SmartStream Designer file can be a PDF or an HPD template file. HPD Template files can be used
in HP SmartStream Composer or HP SmartStream Director to produce output files in those products.

Provided the PDF source file is sufficiently complex, each variation created by the application is unigue. The
cover of this guide features a project created with HP Mosaic.

Figure 1-1 Example PDF source file and HP Mosaic output

Who can benefit from reading this document?
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2 (Getting started with the Sample job

The following steps are the recommended first steps to use HP Mosaic.
1. Download HP Mosaic 2.0 Sample Job.zip and HP Mosaic 3.0 Sample Job.zip
These ZIP file is available on the My HP Indigo portal for HP SmartStream Designer.

[%”f NOTE: HP Mosaic 3.0 Sample Job uses the Shuffle Spot Colors option that is available only with the latest
HP SmartStream Designer 11.4 for InDesign CC2015.4.

a. Goto https://myhpindigo-int-pro.houston.hp.com/Technical/SmartStream/SSdesigner/Pages/
default.aspx.

b.  Select HP SmartStream Designer for Adobe InDesign

¢.  Click Quick Links. Then click Designer Enhancements — Dynamic Personalization and open the
HP Mosaic link.

d. Locate the HP Mosaic Sample Job.zip files, and then download them.
2. Unzip the relevant HP Mosaic Sample Job.zip.

It contains a sample Adobe InDesign file, related files, and PDF source files for the HP Mosaic application
(Seed files). The figure illustrates the file structure.

Figure 2-1 HP Mosaic 2.0 Sample Job.zip file structure

.. DesignerLinks » . Mosaic »{ T Diamonds.pdf
. Document fonts | Demo_Template_file.t @ Explosions.pdf
Bl Mosaic 2 Sample Job.indd __| Mosaic 2 Sample Job.impp| | T Melting.pdf
| VersionInfo.bxt | Mosaic 2 Sample Job.bt

Figure 2-2 HP Mosaic 3.0 Sample Job.zip file structure

A A

.. DesignerLinks » . Mosaic

TXi 13_Love_Spot_17:17 pdf

.. Links __ Sample31.t¢
B Mosaic 3 Sample job with Shuffle.indd _ | Sample 3.b¢t

|| VersionInfo. bt

E,?% NOTE: The HP Mosaic 3.0 Sample Job contains a Seed file with Spot colors. This job utilizes the
Shuffle Spot Colors option.

3. Open the DesignerLinks folder, which contains a Mosaic folder and the template file (.txt).

4.  Copy the Seed Files to the folder on the local computer where variable assets are stored to be used later
with other HP Mosaic jobs. Provided in this folder are 3 vector PDF Seed files for the Mosaic 2.0 Sample job
and 1 Seed file for the Mosaic 3.0 Sample Job.

E,?% NOTE: Itis recommended to start working with HP Mosaic by opening the supplied sample job, reviewing
its Image Channel definition, and then create your own jobs.
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Workflow

Workflow steps
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1.
2.

Open an Adobe InDesign or Illustrator document.

Using the HP SmartStream Designer menu, select a database file that includes at least 1 field with numeric

data (whole numbers larger than zero), and then define an Image Channel.

Double-click the channel row in the Channels palette to open the Image Channel window.

Figure 3-1 Image Channel window

A 4 @ Fitting:

Fit Content to Frame

Colored Auto Rotate

[_'I' [ Align:
HEE
AN
HEm

mages Path

Use Default
Suppress Preview

Cancel

a.  Select Dynamic Image from the Type dropdown list.
b.  Select HP Mosaic from the Application dropdown list.

€.  Select the preferred option from the Fitting dropdown list.

Settings...

d. Forthe Images Path, select the path where the Seed files are located. The Images Path location in
this example, for PC, is C:\Mosaic. An example path for Macintosh is Macintosh HD:Mosaic

Workflow steps

5



e.  (lick Settings.

The Dynamic Personalization Settings window opens.

Figure 3-2 Dynamic Personalization Settings window

Template file: Demo_Template_file

Mapping Variables:

Variables Data Fields
index I

Data Fields:
First
Las
Picture.jpg
Grade
Title
« 1D

4.  Inthe Dynamic Personalization Settings window for a new job, the Demo_template_file is selected by
default.

99

= NOTE: The Demo_template_file is a protected file (locked). Use the Save As B button to save a copy of
the template file to enable editing.

5. Inthe Mapping Variables pane, select a database (DB) file that contains numeric data (positive whole
numbers). Each number generates a unique HP Mosaic image.

6.  Toproceed with a workflow that does not use additional editing options, click OK to close the Image
Channel definition window. Without using the editing option, the job uses the Seed files that are related to
the supplied sample job. To replace the Seed file, see Use HP Mosaic editing options on page 7.

HP Mosaic Image channel indication

e  HPSmartStream Designer for Adobe Illustrator. There is no special indication. The HP VDP logo
displays in the center of the channel.

e  HPSmartStream Designer for Adobe InDesign: The channel indicator now includes the following
information.

— The HP Mosaic Template name

— Anorange gear icon that indicates Dynamic Personalization

6 Chapter 3 Workflow ENWW



Figure 3-3 HP Mosaic Image Channel for Adobe Illustrator (1) and InDesign (2)

<
o

<Demo_Teanplate fil e;%

2,

7. Select the HP SmartStream Designer Preview palette to enable preview of the results.

Use HP Mosaic editing options

ENWW

It is possible to edit the HP Mosaic parameters with the HP Mosaic Template Editor. The changes are saved in the

HP Mosaic Template file (txt) that is associated with the job.

The following parameters can be edited:

e  Addanother Seed set or duplicate an existing Seed set and edit its content.

e  Add, replace, or delete Seed files

e  Edit the parameters of a Seed file.

Follow these steps to open the HP Mosaic Template Editor:

1. For a Dynamic Personalization Image Channel with HP Mosaic definitions, open the Image Channel window

which is already defined as a Dynamic Image/HP Mosaic channel.

2. Double-click the channel row in the channel palette.

Use HP Mosaic editing options
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3. Inthelmage Channel window, click Settings.
The Dynamic Personalization Settings window opens.

Figure 3-4 Dynamic Personalization Settings window

B: @

Mapping Variables:

UEGERIES Data Fields

index D

Data Felds:
First

. Last
Edit... (:) Picture.jpg

Grade
Title
1D

4. Toenable editing, click Save As B to save a copy of the original template file.

[%r NOTE: The original template file is locked and cannot be edited.

5. If you created a new template file previously, click Load to browse for the file, and then select it.
6.  Inthe Dynamic Personalization Settings window, click Edit.

The HP Mosaic Template Editor window opens.

Edit at the Seed Set level

The main HP Mosaic Template Editor window enables editing at the Seed Set level. A Seed Set is a group of
individual Seed files.

In the HP Mosaic 2.0 Sample Job, the default template contains 1 Seed Set which contains 3 individual Seed files,
Diamonds.pdf, Melting.pdf, and Explosions.pdf.

8 Chapter 3 Workflow ENWW
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Figure 3-5 HP Mosaic Template Editor - Main window

i+ Masaic Tempilate Editor (W2.0.1) - MasaicL.txt contains 1 seed sets) L= | ]

rSet1
Range

Seeds

w ®@ ® ©

Deliite Sat Displicatie Set Edit St

E

1 Range Displays maximum range for the number of combinations that can be created from the defined Seed
Set

2 Seeds Lists the Seed files included in the Seed Set.

3 Delete Set If multiple Seed Sets are defined for a given template, use this function to remove one or more.

4 Duplicate Set Use this function to create a copy of another defined Seed Set.

5 Edit Set Use this function to edit the settings for a defined Seed Set.

6 Add Set Use this function to add an empty Seed Set for which you will need to define parameters.

For any Seed Set, the Seed files and Range must be defined. The Range is the range of DB records for which the

defined Seed files will be used to create Mosaic images.
For example, two Seed Sets could be defined for a given template as follows:
e Setl:
— Range: 1-299, 999
— Seedfiles: Mel ti ng, Expl osi ons, Dr agons, Di anonds
e Setz:
— Range: 300, 000—-399, 999

— Seedfiles:Bl ui sh fl owers, Bl ui sh shapes

Use HP Mosaic editing options
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Figure 3-6 HP Mosaic Template Editor - New Seed Sets

' ™y
|£| Mosaic Template Editor (V2.0.3) - HP Mosaic 2.0 demo.bxt contains 2 seed set(s) EI_Iﬂ

rSet1-

Range:
Seeds: Melting, Explosions, Dragons, Diamonds

Description:

Delete Set Duplicate Set Edit Set

Range: 300,000 - 39

Seeds: Bluish flowers, Bluish shapes

Description:

Delete Set Duplicate Set Edit Set

Add Set

he A

Note that the Range index of any added Seed Set starts with the value +1 of where the previous Seed Set ends.

If the DB file that contains the numeric data for the HP Mosaic channel is a simple counter (1,2,3,...350,000),
then:

e  ForDBrecords 1-299, 999, the Seed files in Set 1 are used to define Mosaic images.
e  ForDBrecords 300, 000 and higher, the Seed files in Set 2 are used to define Mosaic images.

If the DB field contains non-counter numbers (such as ID numbers) and a number is within the range of
1-299,999 (such as 123,456), then the HP Mosaic variation that is created for it is generated using the Seed files
of Set 1.

10 Chapter 3 Workflow ENWW



Edit Seed Set and Seed file parameters

Click Edit Set in the Mosaic Template Editor opens the Edit Set window.
Figure 3-7 Edit Set window

Set Name: Set1
Start Index: 1
End Index: 4899999

Set Description:

Seed Path: C:AUsers\nea.AUTH\Neta\YTD ID\1 2\Mosaic 2 sample job\Mosaic 2 Sample Job\De

[ERCT O ESIEIIO 13 Love SpotColors_17x17*
Seed File: 13_Love_SpotColors_17x17

Minimum Scale: il
Maximum Scale: 10

Rotation: @ Hone
O Free Rotation

o By ]

Shuffle Spot Colors Edit

Seed Description:

Add Seed Duplicate Seed Delete Seed Cancel

In the Edit Set, it is possible to define the parameters for both the Seed Set as well as the individual Seed files
contained in the Set.

1.  Define the Seed Set parameters.
e  Set Name: Type a name for the Seed Set.
e  Start Index: Define the first DB record in the Range for this Seed Set.
e  EndIndex: Define the last DB record in the Range for this Seed Set.
e  Set Description: Provide a brief description of the Seed Set for reference.
e  Seed Path: Designate the directory location for the Seed files.
After the Seed Set, parameters are defined, proceed to the individual Seed file parameters.

2. Select a Seed file from the Seed File dropdown list. Any Seed file that is available at the designated Seed
Path is available to select. Take note of the recommendations in Seed file design recommendations

on page 15.

3. Set the Minimum Scale and Maximum Scale values for the HP Mosaic image output.
The default values range from 1 (100%) to 10 (1,000%) enlargement.

4.  Set the Rotation. The available options are the following:
e  None: No rotation to images to produce output.
e  Free Rotation: Any angle rotation is allowed to produce output.

e  FEvery [X degrees]: Specify the step angle to use for each rotation, e.g. Every 45°, by selectinga
value from the dropdown list.

ENWW Use HP Mosaic editing options



5. Add a Seed Description to summarize the settings or Seed file use, if necessary.

6.  Add, Duplicate, or Delete Seeds as desired.

[%9 NOTE: If the same settings will be used for multiple Seed files in the same Seed Set, define the settings
for one Seed, and then add additional Seeds with the Duplicate Seed option. This option copies all the
defined settings so the only required update is the Seed Name.

7. The Shuffle Colors option is available for Seed files that are defined with Spot colors.
For a Seed file defined with Spot colors, it is possible to do any of the following:
e  Shuffle between the Spot colors.
e  Replace Spot colors with a predefined set of different Spot colors.
e  Replace up to 12 Spot colors with a user defined set of Spot colors.
To shuffle colors, do the following:
a.  Select the Shuffle Spot Colors check box and click Edit.

b. Inthe Edit Spot Colors window that appears, HP Mosaic identifies the document’s Spot colors, if there

areany.
=

M |Select All
[ EE

"

Light#20Red

Dark#20Brown
Lighter#20Red
Love#20Red

: Brown#20Grey
Love#200range

Bordo

O Shuffle selected colors

#® Replace with set colors

set1 []

Select Spot colors to be shuffled by selecting the check boxes next to their names.

c.  Select one of the following radio buttons:

12 Chapter 3 Workflow ENWW



e  Shuffle selected colors — to shuffle selected colors among themselves.

e  Replace with set colors — to replace the selected colors with a different set from the predefined
list of 5 sets. Click the dropdown arrow icon [l to see the list of the predefined sets.

d.  Foreachselected predefined set, you can do one of the following:

° Useitasis.

®  Edit one or more of its colors by clicking the Edit icon !

€. Tocreate anew set of up to 12 Spot colors, click the Plus icon .

f.  Inthe Custom Set window that appears after clicking the Edit or Plus icon, you can edit a Spot color
set.

i £} - ‘ B’
Custom Set ﬁ
Title [=INEY |

new color_0 new color_1
. new color_2

new color_4

new color_&

¥ . new colo F_E: unu E-E'd_g
. new color_10 unused 11

Delete Set

v

L

To edit a Spot color, click its colored square. In the RGB/CMYK window that appears, select the
required color using the sliders and color patch.

o

@Red O 1 |_152p
O Green Q| 2557
) Blue ¢ OW

Alpha ° | 2858514

Color Code | 98FFFF|

Cancel || Reset

ENWW Use HP Mosaic editing options 13



8.  (Optional) Add a Seed Description.
9.  After the updates are complete, click OK to confirm the changes.

The next chapter provides further details and recommendations for creating Seed files and defining their HP
Mosaic parameters.

14 Chapter 3 Workflow ENWW



4  Seed file design recommendations

The following are recommendations to consider when defining Seed files to use in HP Mosaic jobs.

Seed file recommendations

File type
[ ]

Seed files are Vector PDF

Any application that can produce Vector PDF output, e.g. Adobe Illustrator, can create Seed files

File size and weight

Mode

Seed files must be square (equal height and width)

Seed file size can be up to 3.0 MB. The smaller the file (in MB), the faster the create output file process is
for creating the HP Mosaic variations.

For multiple use elements, use tools such as the Adobe Illustrator Stamp option to help minimize the file
weight

The color mode should be CMYK (not RGB) and can include Spot Colors if required

EJ?"” NOTE: The Shuffle Spot Colors option is enabled only for Seed files that are defined with Spot colors.

How to design the Seed files

Use vibrant, contrasting colors

To enable scaling up while preserving the Seed file design, use small design elements and thin elements,
e.g. add frames to elements

Use chaotic patterns and “untidy” design, i.e. non-linear designs and not like a checkerboard

Optimize Seed file size in MB without reducing graphic complexity

ENWW

Reduce the vector points and if using Adobe Illustrator, use Adobe Illustrator’s Simplify command (Object >
Path > Simplify)

Remove unneeded data and if using Adobe Illustrator, remove hidden elements in the PDF by selecting File
> Save as PDF, and then unchecking Preserve Illustrator Editing Capabilities

Manually combine vector elements and diminish the vector points in the document with Adobe Illustrator’s
Pathfinder (Window > Pathfinder)

If applicable, knock-out overlapping element’s using Pathfinder's Merge or Trim tools
The pattern must be vector

The Seed file should be saved as Vector PDF

Seed file recommendations

15



Preview for Proofing

e  Before creating the final PDF output file or HPD Template file, use HP SmartStream Designer’s Preview
option to review the output

[%’ NOTE: Itis recommended to define only one Seed per Seed Set for the purpose of Preview and review,
and then combine the individual Seeds later into a single Seed Set.

e  Preview for about 10-20 records for each Seed to make sure that the enlargement percentage maintains
the look and feel of the design

HP Mosaic Scale and Rotate recommendations

Scale

The decision of how much to scale depends on the individual Seed file.

1. Example 1: The look and feel of a Seed file can be lost when large scaling is used. The nature of the Seed
can be lost as in the results in the following figure. The 600%and 800%scale results lose the effect of the
Seed file. The decision of the graphic designer in this case, based on Preview trials, might be to scale up to
4 (400%) times larger and no more.

Figure 4-1 Scale —Example 1

* Seed file 200% 600% ‘ 800%

2. Example 2: Text in the Seed file is a consideration for scaling. Large scaling can result in not being able to
see the characters or words in each of the output files.

Figure 4-2 Scale — Example 2

Ve love
,3lwe w&ﬂ ! %i%

loiJ"e Lo @ O)E

g m@‘fﬁ%«f

ani‘s' &l Ao e
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Rotate
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3. Example 3: Seed files that include thin lines (framing) enable larger scaling options while maintaining the
Seed’s primary characteristics. For example, in the following figure, review the results for 200% 400%
and 800%scaling.

The graphic designer in this case might decide, based on Preview trials, to scale up to 8 (800%) times
larger.

Figure 4-3 Scale — Example 3

I ) =

Seed file 200% 400%

The default rotation is for Free Rotation. However, some Seed file content might lose its context under rotation,
e.g. written text. Adjustments to the Rotate setting can accommodate such content.

Preview tests can help determine when not to rotate or when to rotate in step increments of 90°, 45°, etc. This is
a Seed design related decision and varies on a case-by-case basis. In the second example in the preceding
section, no rotation was used to maintain the text orientation in the graphic(s).

HP Mosaic Scale and Rotate recommendations
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Creating a Seed file from a JPG image

The Seed file is a Vector PDF. In order to create a Seed file from a JPG image, the JPG must be vectorized
(traced).

Follow these steps to trace a JPG image in Adobe Illustrator, and then convert it to an HP Mosaic seed file.

1. Create asquare JPGfile.

Figure 4-4 Square JPG example

2. Open the JPG file with Adobe lllustrator, click Select, and then select All.
3. Click the arrow next to Image Trace, and then select High Fidelity Photo from the Tracing Presets.

Figure 4-5 Image Trace - High Fidelity Photo

& Colors

Shades of Gray

Silhouettes

Line Art
Technical Drawing
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4,  Click Expand.
Figure 4-6 Expand button

Effect Wiew Window

w:  Tracing Result

0% (RGE/Preview)
Adabe Illustrator creates a vector image of the JPG graphic.

Figure 4-7 Vector image example

5. Open the File menu, and then click Save As.

6.  Provide a File name, select Adobe PDF as the file type, and then click Save.

@7 NOTE: Make sure that the Seed file size (in MB) does not exceed the recommended size. Refer to
recommendations on how to Optimize Seed file size in MBin Seed file recommendations on page 15.

7. Use this new vector image as the Seed file to produce HP Mosaic output files.

%
FEEREEN

u u ] " [t "

Figure 4-8 HP Mosaic output examples

ENWW Creating a Seed file from a JPG image
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5 Seed files Q&A
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Why would | have 2 Seed sets?

If, as an example, you want to create 50,000 random images and the DB field selected for the HP Mosaic
channelis a counter (1,2,3...50,000). The first 25,000 to be created from two seed files and the other
25,000 from a third seed file. You can define two Seed sets. The first two Seeds are defined in one set, and
then the third Seed is defined in the second Seed set.

Another case for having more than one Seed Set is if you want to change Seed parameters after
production has already started. If you have more than one Seed Set, you can change the Seed parameters
for future copies without impacting copies that were already processed should you need to reproduce
them.

What if my numeric data includes repeated values?

With the Template parameters unchanged and the Seed settings unchanged, the same DB value defines
the same image.

How do | work with HP Mosaic 3.0 in HP SmartStream Designer 11.0 for Adobe InDesign CC2015 or HP
SmartStream Designer 6.3 for Adobe InDesign CS6?

You need to upgrade.
—  SmartStream Designer 11.0 for InDesign CC2015: Upgrade to SmartStream Designer 11.4.

—  SmartStream Designer 6.3 for Adobe InDesign CS6: Manually upgrade the Mosaic to 3.0. HP Indigo
support will instruct you with the upgrade steps.

How to define an HPD for Rich PDF or for Fast PDF

When creating the HPD template file, in the HP SmarStream Designer for InDesign Pack Job window, mark
it for the PDF Fast workflow by selecting the Include Fast Template option.

When creating the HPD template file, in HP SmarStream Designer for Illustrator it is always HPD Fast, with
no option to change it.

To also include the Seed files in the HPD template file, also select the Include variable assets option in the
Pack Job window. See the next chapter for further details on creating the HPD file.

What do | do to match the leading color of Seed files to another image channel’s colors?

In the following example, there are two HP Mosaic channels. The two channels have exactly the same
settings, parameters, and the same DB field is selected for both channels. The only difference is the Seed
files:

— (Channel 1: Includes 3 Seed files with multiple colors and elements. The leading colors are green,
black, and red.

— (Channel 2: Includes 3 Seed files of solid colors in the same order of green, black, and red.

With the same Seed settings and DB field, the same selections and calculations are made for both of the
channels for every record.

For example for a specific record, if the “greenish” Seed is selected for Channel 1, the solid green is
selected for Channel 2.

21



Figure 5-1 Example: Matching colors across HP Mosaic channels
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6 Create an output file or HPD template file

Create an output file

HP SmartStream Designer for Adobe InDesign
1. From the HP SmartStream Designer menu, select Create Job to create an output file.
2. From the Format dropdown list, select PDF.

3. Adjust other settings as needed for the HP SmartStream Designer workflow, and then click Create.

HP SmartStream Designer for Adobe Illustrator
1. From the HP SmartStream Designer menu, select Create Job to create an output file.

2. Adjust other settings as needed for the HP SmartStream Designer workflow, and then click Create.

Create an HPD template file

An HP template file is necessary for any workflow that includes one or more of the following:

e  HPSmartStream Composer

e  HPSmartStream Composer-Lite

e  HP SmartStream Director

e  HP SmartStream Designer Hot Folder workflow

The HPD template file is sent to these other products. Follow these steps to create an HPD template file.
1. From the HP SmartStream Designer menu, select Pack Job. The Pack Job window opens.

Figure 6-1 Pack Job window (in HP SmartStream Designer for InDesign)

P
Pack Job |
Package Content
v Include variable assets
= From Assets Folder

From database

V| Include Fast Template

Show Report

Cancel

ENWW Create an output file
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Figure 6-2 Pack Job window (in HP SmartStream Designer for Illustrator)

Package Content

¥ Include variable
* From Assets Folder

From database

Cancel

. F
e Include variable assets: Select this option to include variable assets from the Assets folder in the HPD
file. If selected, the HP Mosaic Seed files will be included in the HPD file.

If the files are not included, the location of the files must be defined manually in HP SmartStream
Composer, and then the files copied to the designated location.

e Include Fast Template (in HP SmartStream Designer for InDesign):

— For sending an HPD file to HP SmartStream Composer, select the Include Fast Template option
for better performance (optional).

— For sending an HPD file to HP SmartStream Composer - Lite, the Include Fast Template option
must be selected. It is required.
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B NOTE: Designer for Illustrator creates HPD files with the Fast Template option included. It is
not an option in the Ul as it is always ON.

2. Send the HPD file to HP SmartStream Composer, Composer-Lite, or Director, and then continue the
standard VDP workflow.
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A  Service and support

To obtain service, please contact the customer care center within your country/region:

Europe:
Belgium: +32(0)2 626 4803
France: +33(0)1 57 324107
Germany: +49 (0)69 38 07 89 193
Ireland: +353(0)1 656 9760
Italy: +39 02 69430637
Luxembourg: +352(0)24 87 1398

Netherlands:

+31(0)20 547 6870

Spain: +34 912757781

UK: +44 (0)84 5604 7435
APJ:

Japan: +81(0)1 2085 5536

Singapore: +659891 1753

Distribution Channels (DC):

+31(0)20 654 5543

North America: 1-800-204-6344

Israel: +972 (089381818

North America and International Israel APJ

Latin America

HP HP HP HP

Indigo Division Indigo Division Indigo Division Asia Pacific Pte Ltd
5555 Windward Parkway Startbaan 16 Kiryat Weizmann No.3 Tuas Link 4 #02-01
Alpharetta, GA 30004 1187XR Amstelveen P.0.Box 150 Singapore 637016

USA The Netherlands Rehovot 76101

ENWW

Israel
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Printing instructions
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B NOTE: Toensurea high quality print, use the CA494-14161_print.pdf version of this document.

COVER
Paper weight 250g
Page size 8.27x11.001in (21 x 27.94 cm)
Printing HP Indigo digital press
Simplex/duplex Front cover - duplex

Rear cover - simplex
Color Full color - high resolution
Coating Lamination - shiny front and rear covers
INSIDE PAGES
Paper weight 80g
Page size 8.27 x11.001in (21 x 27.94 cm)
Printing HP Indigo digital press
Simplex/duplex Duplex
Color Full color - high resolution
Coating None
FINISHING
Stitch 2 saddle stitch on left side

Appendix A Service and support
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